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These tips are necessary evils, but most works in almost every Windows program, and most are easy to remember. So get to work memorize, memorize, memorize…

· Adding Horizontal Dividers in Word
To add a variety of horizontal dividers in Word, type three characters and press enter.
	Hyphens ( --- )
	

	Underscores ( ___ ) 
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	Equal Signs ( === )
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	Hash Signs ( ### )
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	Asterisks ( *** )
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	Tildes ( ~~~ )
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· Type Out a Table in Word
You can create tables in Microsoft Word by simply typing out a string of PLUS SIGNS (+) and MINUS SIGNS (-). 

Start the row with a PLUS SIGN (+) and then type MINUS SIGN (-) until you have the column width you want. To add a new column type PLUS SIGN (+) again. When you're done type a final PLUS SIGN (+) and press ENTER. Word turns your text into a table. To add more rows to your table, move to the last cell in the table and press TAB. 

· Filling Word Documents with Pretend Text

If you want to fill a page(s) with text to test something like printing, but don't want to spend time pasting the same phrase over and over,
Type in =rand(x,y)  and press "enter" .
Where x and y are replaced by numbers. 
X would be the number of paragraphs
Y would be the number of sentences in a paragraph.
The text that gets generated is ‘The quick brown fox jumps over the lazy dog.’ 
· Select a vertical block of text


Press Alt + drag

· Quickly Replicate Text or Graphics in Word

Here's a quick way to make copies of text or graphics in Word: 

1. Select the item or text you want to copy. 

2. Press and hold down the CTRL key. 

3. Then use the mouse to drag the item to the desired position. 

A copy of the original item is made right where you want it. This is helpful when you're creating a document that will include a lot of repeated text or images.

· Quickly Change Font Size in Office


To quickly change the font size in your Office application (Word, Front Page, 
Publisher or PowerPoint):

1. 
Highlight the text you want to change 

2. 
Press: 



CTRL+SHIFT+> - To Increase the size


CTRL+SHIFT+< - To Decrease the size
· Use your keyboard to quickly change the case of text in Microsoft Word

Select the text you want to change and press SHIFT+F3. Each time you press the F3 key, the text case switches between Title Case, UPPERCASE, and lowercase.

· Insert Current Date and Time in Word

You can insert the current date or time in a Word document using keyboard 
shortcuts. Here's how: 

1. Position the cursor where you want to insert the date or time. 

2. Do one of the following: 

· To insert the date, press ALT+SHIFT+D. 

· To insert the time, press ALT+SHIFT+T. 

· Close all word documents without closing Word

Shift + click the File menu then select Close All
Shift + clicking on the File menu give one more option Save All

· Return to the last place you were working
Return to the last place you were working or the place before that or before that. 
Press Shift + F5 repeatedly to return to last 5 cursor positions (even if one of those positions is in another open document).
This one’s even cleverer, when you first open a document, press shift + F5 to jump to the last place you or someone else edited before closing the document.

· Cycle through all open documents 

To cycle through all open documents press Ctrl + F6 +F6 +F6….

It works for Photoshop and others applications as well.

· Whether you’re saving a file or opening a file try these shortcuts

Alt + 1 Go to previous folder


Alt + 2 Go up one folder level


Alt + 3 Search the web


Alt + 4 or Delete deletes selected file.


Alt + 5 Create a new folder


Alt + 6 repeatedly Cycle through all views.


Alt + 7 Display the Tools menu

· Determining Formatting in Word

To determine what formatting is applied to a particular paragraph in Word:

1. Go to Help / What's This? 

2. When the cursor changes to a question mark, click on the paragraph. 

3. Information such as font and size, alignment, indent, spacing and margins will show.
· Reducing the File Size of Word Documents

If you have make documents using MS Word and you make many formatting changes for the paragraph, fonts, page etc., you will see your file size gets bigger. Microsoft Word saves files by blocking, so any change you made for your document it will create a new block with the new formatting and disappear the old block without deleting it from the file.

You can solve this problem.

1. If you open your file and select File \ Save As and give your file a new name, it will save only the active blocks with out the old ones. 

2. If you compare the two files you will see a difference in size 
There is, however, a much easier way.

1. Choose Tools 

2. Options...  

3. Open the Save tab  

4. Uncheck Allow Fast Saves 

This makes Word rewrite the entire document file from scratch each time it is saved. The save command takes slightly longer, but your files can be drastically smaller (especially if you've done lots of formatting changes).

· Complete list of word short cut keys
	Command Name
	Modifiers
	Key
	Menu

	About
	
	
	Help

	All Caps
	Ctrl+Shift+
	A
	

	Annotation
	Alt+Ctrl+
	M
	

	App Maximize
	Alt+
	F10
	

	App Restore
	Alt+
	F5
	

	Apply Heading1
	Alt+Ctrl+
	1
	

	Apply Heading2
	Alt+Ctrl+
	2
	

	Apply Heading3
	Alt+Ctrl+
	3
	

	Apply List Bullet
	Ctrl+Shift+
	L
	

	Arrange All
	
	
	Window

	Auto Correct
	
	
	Tools

	Auto Format
	Alt+Ctrl+
	K
	

	Auto Format Begin
	
	
	Format

	Auto Summarize Begin
	
	
	Tools

	Auto Text
	
	F3
	

	Auto Text
	Alt+Ctrl+
	V
	

	Background Fill Effect
	
	
	Format Background

	Background More Colors
	
	
	Format Background

	Bold
	Ctrl+
	B
	

	Bold
	Ctrl+Shift+
	B
	

	Bookmark
	Ctrl+Shift+
	F5
	Insert

	Bookshelf Lookup Reference
	
	
	Tools

	Break
	
	
	Insert

	Browse Next
	Ctrl+
	Page Down
	

	Browse Prev
	Ctrl+
	Page Up
	

	Browse Sel
	Alt+Ctrl+
	Home
	

	Cancel
	
	Esc
	

	Center Para
	Ctrl+
	E
	

	Change Case
	
	
	Format

	Change Case
	Shift+
	F3
	

	Char Left
	
	Left
	

	Char Left Extend
	Shift+
	Left
	

	Char Right
	
	Right
	

	Char Right Extend
	Shift+
	Right
	

	Clear
	
	Del
	Edit

	Clip Art
	
	
	Picture Menu

	Close
	
	
	File

	Close Pane
	Alt+Shift+
	C
	

	Column Break
	Ctrl+Shift+
	Enter
	

	Column Select
	Ctrl+Shift+
	F8
	

	Compare Versions
	
	
	Track Changes Menu

	Copy
	Ctrl+
	C
	

	Copy
	Ctrl+
	Ins
	

	Copy Format
	Ctrl+Shift+
	C
	

	Copy Text
	Shift+
	F2
	

	Create Auto Text
	Alt+
	F3
	

	Cross Reference
	
	
	Insert

	Customize
	
	
	Tools

	Customize Add Menu Shortcut
	Alt+Ctrl+
	=
	

	Customize Keyboard Shortcut
	Alt+Ctrl+
	Num +
	

	Customize Remove Menu Shortcut
	Alt+Ctrl+
	-
	

	Cut
	Ctrl+
	X
	

	Cut
	Shift+
	Del
	

	Date Field
	Alt+Shift+
	D
	

	Date Time
	
	
	Insert

	Delete Back Word
	Ctrl+
	Backspace
	

	Delete Word
	Ctrl+
	Del
	

	Do Field Click
	Alt+Shift+
	F9
	

	Doc Close
	Ctrl+
	W
	System

	Doc Close
	Ctrl+
	F4
	System

	Doc Maximize
	Ctrl+
	F10
	System

	Doc Minimize
	
	
	System

	Doc Move
	Ctrl+
	F7
	System

	Doc Restore
	Ctrl+
	F5
	System

	Doc Size
	Ctrl+
	F8
	System

	Doc Split
	Alt+Ctrl+
	S
	Window

	Double Underline
	Ctrl+Shift+
	D
	

	Draw Group
	
	
	Draw

	Draw Picture Automatic
	
	
	Image Control

	Draw Picture Black and White
	
	
	Image Control

	Draw Picture Grayscale
	
	
	Image Control

	Draw Picture Watermark
	
	
	Image Control

	Draw Regroup
	
	
	Draw

	Draw Set Arrow Style
	
	
	Arrow

	Draw Shadow Color
	
	
	Shadow Color

	Draw Shadow Customize
	
	
	Shadow

	Draw Shadow Semi Transparent Toggle
	
	
	Shadow Color

	Draw Show Auto Shapes and Drawing Toolbars
	
	
	Picture Menu

	Draw Snap to Grid
	
	
	Draw

	Draw Ungroup
	
	
	Draw

	Draw Word Art Align Center
	
	
	WordArt Alignment

	Draw Word Art Align Left
	
	
	WordArt Alignment

	Draw Word Art Align Letter Justify
	
	
	WordArt Alignment

	Draw Word Art Align Right
	
	
	WordArt Alignment

	Draw Word Art Align Stretch Justify
	
	
	WordArt Alignment

	Draw Word Art Align Word Justify
	
	
	WordArt Alignment

	Draw Word Art Kern
	
	
	WordArt Tracking

	Draw Word Art Spacing Loose
	
	
	WordArt Tracking

	Draw Word Art Spacing Normal
	
	
	WordArt Tracking

	Draw Word Art Spacing Tight
	
	
	WordArt Tracking

	Draw Word Art Spacing Very Loose
	
	
	WordArt Tracking

	Draw Word Art Spacing Very Tight
	
	
	WordArt Tracking

	Draw3 DColor
	
	
	Extrusion Color

	Draw3 DCustomize
	
	
	3-D Effect

	Draw3 DDepth Infinite
	
	
	Extrusion Depth

	Draw3 DDepth0
	
	
	Extrusion Depth

	Draw3 DDepth1
	
	
	Extrusion Depth

	Draw3 DDepth2
	
	
	Extrusion Depth

	Draw3 DDepth3
	
	
	Extrusion Depth

	Draw3 DDepth4
	
	
	Extrusion Depth

	Draw3 DLighting Flat
	
	
	3-D Lighting

	Draw3 DLighting Harsh
	
	
	3-D Lighting

	Draw3 DLighting Normal
	
	
	3-D Lighting

	Draw3 DParallel
	
	
	Extrusion Direction

	Draw3 DPerspective
	
	
	Extrusion Direction

	Draw3 DSurface Matte
	
	
	3-D Surface Material

	Draw3 DSurface Metal
	
	
	3-D Surface Material

	Draw3 DSurface Plastic
	
	
	3-D Surface Material

	Draw3 DWire Frame
	
	
	3-D Surface Material

	Drawing Object Wrap None
	
	
	Text Wrapping

	Drawing Object Wrap Square
	
	
	Text Wrapping

	Drawing Object Wrap Through
	
	
	Text Wrapping

	Drawing Object Wrap Tight
	
	
	Text Wrapping

	Drawing Object Wrap Top Bottom
	
	
	Text Wrapping

	End of Column
	Alt+
	Page Down
	

	End of Column
	Alt+Shift+
	Page Down
	

	End of Doc Extend
	Ctrl+Shift+
	End
	

	End of Document
	Ctrl+
	End
	

	End of Line
	
	End
	

	End of Line Extend
	Shift+
	End
	

	End of Row
	Alt+
	End
	

	End of Row
	Alt+Shift+
	End
	

	End of Window
	Alt+Ctrl+
	Page Down
	

	End of Window Extend
	Alt+Ctrl+Shift+
	Page Down
	

	Endnote Now
	Alt+Ctrl+
	E
	

	Envelopes and Labels
	
	
	Tools

	Exit
	Alt+
	F4
	File

	Extend Selection
	
	F8
	

	Field
	
	
	Insert

	Field Chars
	Ctrl+
	F9
	

	Field Codes
	Alt+
	F9
	

	Find
	Ctrl+
	F
	Edit

	Font
	Ctrl+
	D
	

	Font
	Ctrl+Shift+
	F
	

	Font Size Select
	Ctrl+Shift+
	P
	

	Footnote
	
	
	Insert

	Footnote Now
	Alt+Ctrl+
	F
	

	Footnotes
	
	
	View

	Formula
	
	
	Table

	Go Back
	Shift+
	F5
	

	Go Back
	Alt+Ctrl+
	Z
	

	Go To
	Ctrl+
	G
	Edit

	Go To
	
	F5
	Edit

	Gridlines
	
	
	Table

	Grow Font
	Ctrl+Shift+
	.
	

	Grow Font One Point
	Ctrl+
	]
	

	Hanging Indent
	Ctrl+
	T
	

	Header
	
	
	View

	Header Footer Link
	Alt+Shift+
	R
	

	Headings
	
	
	Table

	Help
	
	F1
	

	Hidden
	Ctrl+Shift+
	H
	

	Hyperlink
	Ctrl+
	K
	

	Indent
	Ctrl+
	M
	

	Index and Tables
	
	
	Insert

	Italic
	Ctrl+
	I
	

	Italic
	Ctrl+Shift+
	I
	

	Justify Para
	Ctrl+
	J
	

	Language
	
	
	Language

	Left Para
	Ctrl+
	L
	

	Letter Properties
	
	
	Tools

	Line Down
	
	Down
	

	Line Down Extend
	Shift+
	Down
	

	Line Up
	
	Up
	

	Line Up Extend
	Shift+
	Up
	

	Links
	
	
	Edit

	List Num Field
	Alt+Ctrl+
	L
	

	Lock Fields
	Ctrl+
	3
	

	Lock Fields
	Ctrl+
	F11
	

	Macro
	Alt+
	F8
	

	Mail Merge Check
	Alt+Shift+
	K
	

	Mail Merge Edit Data Source
	Alt+Shift+
	E
	

	Mail Merge to Doc
	Alt+Shift+
	N
	

	Mail Merge to Printer
	Alt+Shift+
	M
	

	Mark Citation
	Alt+Shift+
	I
	

	Mark Index Entry
	Alt+Shift+
	X
	

	Mark Table of Contents Entry
	Alt+Shift+
	O
	

	Master Document
	
	
	View

	Menu Mode
	
	F10
	

	Merge Field
	Alt+Shift+
	F
	

	Merge Revisions
	
	
	Tools

	Microsoft On The Web1
	
	
	Microsoft on the Web

	Microsoft On The Web10
	
	
	Microsoft on the Web

	Microsoft On The Web11
	
	
	Microsoft on the Web

	Microsoft On The Web12
	
	
	Microsoft on the Web

	Microsoft On The Web13
	
	
	Microsoft on the Web

	Microsoft On The Web14
	
	
	Microsoft on the Web

	Microsoft On The Web15
	
	
	Microsoft on the Web

	Microsoft On The Web16
	
	
	Microsoft on the Web

	Microsoft On The Web17
	
	
	Microsoft on the Web

	Microsoft On The Web2
	
	
	Microsoft on the Web

	Microsoft On The Web3
	
	
	Microsoft on the Web

	Microsoft On The Web4
	
	
	Microsoft on the Web

	Microsoft On The Web5
	
	
	Microsoft on the Web

	Microsoft On The Web6
	
	
	Microsoft on the Web

	Microsoft On The Web7
	
	
	Microsoft on the Web

	Microsoft On The Web8
	
	
	Microsoft on the Web

	Microsoft On The Web9
	
	
	Microsoft on the Web

	Microsoft System Info
	Alt+Ctrl+
	F1
	

	Move Text
	
	F2
	

	New
	Ctrl+
	N
	File

	New Window
	
	
	Window

	Next Cell
	
	Tab
	

	Next Field
	
	F11
	

	Next Field
	Alt+
	F1
	

	Next Misspelling
	Alt+
	F7
	

	Next Object
	Alt+
	Down
	

	Next Window
	Ctrl+
	F6
	

	Next Window
	Alt+
	F6
	

	Normal
	Alt+Ctrl+
	N
	View

	Normal Style
	Ctrl+Shift+
	N
	

	Normal Style
	Alt+Shift+
	Num 5
	

	Object
	
	
	Insert

	Office Drawing
	
	
	Picture Menu

	Online
	
	
	View

	Open
	Ctrl+
	O
	

	Open
	Ctrl+
	F12
	

	Open
	Alt+Ctrl+
	F2
	

	Open or Close Up Para
	Ctrl+
	0
	

	Options
	
	
	Tools

	Other Pane
	
	F6
	

	Other Pane
	Shift+
	F6
	

	Outline
	Alt+Ctrl+
	O
	View

	Outline Collapse
	Alt+Shift+
	-
	

	Outline Collapse
	Alt+Shift+
	Num -
	

	Outline Demote
	Alt+Shift+
	Right
	

	Outline Expand
	Alt+Shift+
	=
	

	Outline Expand
	Alt+Shift+
	Num +
	

	Outline Move Down
	Alt+Shift+
	Down
	

	Outline Move Up
	Alt+Shift+
	Up
	

	Outline Promote
	Alt+Shift+
	Left
	

	Outline Show First Line
	Alt+Shift+
	L
	

	Overtype
	
	Ins
	

	Page
	Alt+Ctrl+
	P
	View

	Page Break
	Ctrl+
	Enter
	

	Page Down
	
	Page Down
	

	Page Down Extend
	Shift+
	Page Down
	

	Page Field
	Alt+Shift+
	P
	

	Page Numbers
	
	
	Insert

	Page Up
	
	Page Up
	

	Page Up Extend
	Shift+
	Page Up
	

	Para Down
	Ctrl+
	Down
	

	Para Down Extend
	Ctrl+Shift+
	Down
	

	Para Up
	Ctrl+
	Up
	

	Para Up Extend
	Ctrl+Shift+
	Up
	

	Paste
	Ctrl+
	V
	

	Paste
	Shift+
	Ins
	

	Paste As Hyperlink
	
	
	Edit

	Paste Format
	Ctrl+Shift+
	V
	

	Paste Special
	
	
	Edit

	Photo Editor Scan
	
	
	Picture Menu

	Post
	
	
	Send To

	Present It
	
	
	Send To

	Prev Cell
	Shift+
	Tab
	

	Prev Field
	Shift+
	F11
	

	Prev Field
	Alt+Shift+
	F1
	

	Prev Object
	Alt+
	Up
	

	Prev Window
	Ctrl+Shift+
	F6
	

	Prev Window
	Alt+Shift+
	F6
	

	Print
	Ctrl+
	P
	File

	Print
	Ctrl+Shift+
	F12
	File

	Print Preview
	Ctrl+
	F2
	

	Print Preview
	Alt+Ctrl+
	I
	

	Proofing
	
	F7
	

	Properties
	
	
	File

	Protect Unprotect Document
	
	
	Tools

	Record Macro Toggle
	
	
	Macro

	Redo
	Alt+Shift+
	Backspace
	

	Redo or Repeat
	Ctrl+
	Y
	Edit

	Redo or Repeat
	
	F4
	Edit

	Redo or Repeat
	Alt+
	Enter
	Edit

	Repeat Find
	Shift+
	F4
	

	Repeat Find
	Alt+Ctrl+
	Y
	

	Replace
	Ctrl+
	H
	Edit

	Reset Char
	Ctrl+
	Space
	

	Reset Char
	Ctrl+Shift+
	Z
	

	Reset Para
	Ctrl+
	Q
	

	Revision Marks Toggle
	Ctrl+Shift+
	E
	

	Right Para
	Ctrl+
	R
	

	Routing Slip
	
	
	Send To

	Save
	Ctrl+
	S
	

	Save
	Shift+
	F12
	

	Save
	Alt+Shift+
	F2
	

	Save As
	
	F12
	File

	Save Html
	
	
	File

	Select All
	Ctrl+
	A
	Edit

	Select All
	Ctrl+
	Num 5
	Edit

	Select All
	Ctrl+
	Num 5
	Edit

	Select Column
	
	
	Table

	Select Row
	
	
	Table

	Select Table
	Alt+
	Num 5
	Table

	Send to Fax
	
	
	Send To

	Show All
	Ctrl+Shift+
	8
	

	Show All Headings
	Alt+Shift+
	A
	

	Show All Headings
	Alt+Shift+
	A
	

	Show Heading1
	Alt+Shift+
	1
	

	Show Heading2
	Alt+Shift+
	2
	

	Show Heading3
	Alt+Shift+
	3
	

	Show Heading4
	Alt+Shift+
	4
	

	Show Heading5
	Alt+Shift+
	5
	

	Show Heading6
	Alt+Shift+
	6
	

	Show Heading7
	Alt+Shift+
	7
	

	Show Heading8
	Alt+Shift+
	8
	

	Show Heading9
	Alt+Shift+
	9
	

	Shrink Font
	Ctrl+Shift+
	,
	

	Shrink Font One Point
	Ctrl+
	[
	

	Shrink Selection
	Shift+
	F8
	

	Small Caps
	Ctrl+Shift+
	K
	

	Sort
	
	
	Table

	Space Para1
	Ctrl+
	1
	

	Space Para15
	Ctrl+
	5
	

	Space Para2
	Ctrl+
	2
	

	Spike
	Ctrl+Shift+
	F3
	

	Spike
	Ctrl+
	F3
	

	Split
	
	
	Table

	Start of Column
	Alt+
	Page Up
	

	Start of Column
	Alt+Shift+
	Page Up
	

	Start of Doc Extend
	Ctrl+Shift+
	Home
	

	Start of Document
	Ctrl+
	Home
	

	Start of Line
	
	Home
	

	Start of Line Extend
	Shift+
	Home
	

	Start of Row
	Alt+
	Home
	

	Start of Row
	Alt+Shift+
	Home
	

	Start of Window
	Alt+Ctrl+
	Page Up
	

	Start of Window Extend
	Alt+Ctrl+Shift+
	Page Up
	

	Style
	Ctrl+Shift+
	S
	

	Style Gallery
	
	
	Format

	Subscript
	Ctrl+
	=
	

	Superscript
	Ctrl+Shift+
	=
	

	Symbol
	
	
	Insert

	Symbol Font
	Ctrl+Shift+
	Q
	

	Tabs
	
	
	Format

	Templates
	
	
	Tools

	Thesaurus
	Shift+
	F7
	

	Time Field
	Alt+Shift+
	T
	

	To or from Text
	
	
	Table

	Toggle Field Display
	Shift+
	F9
	

	Toggle Master Subdocs
	Ctrl+
	\
	

	Tool
	Shift+
	F1
	

	Toolbars
	
	
	View

	Un Hang
	Ctrl+Shift+
	T
	

	Un Indent
	Ctrl+Shift+
	M
	

	Underline
	Ctrl+
	U
	

	Underline
	Ctrl+Shift+
	U
	

	Undo
	Ctrl+
	Z
	

	Undo
	Alt+
	Backspace
	

	Unlink Fields
	Ctrl+
	6
	

	Unlink Fields
	Ctrl+Shift+
	F9
	

	Unlock Fields
	Ctrl+
	4
	

	Unlock Fields
	Ctrl+Shift+
	F11
	

	Update Auto Format
	Alt+Ctrl+
	U
	

	Update Fields
	
	F9
	

	Update Fields
	Alt+Shift+
	U
	

	Update Source
	Ctrl+Shift+
	F7
	

	VBCode
	Alt+
	F11
	

	Versions
	
	
	File

	Web Go Back
	Alt+
	Left
	

	Web Go Forward
	Alt+
	Right
	

	Word Count
	
	
	Tools

	Word Left
	Ctrl+
	Left
	

	Word Left Extend
	Ctrl+Shift+
	Left
	

	Word Perfect Help
	
	
	Help

	Word Right
	Ctrl+
	Right
	

	Word Right Extend
	Ctrl+Shift+
	Right
	

	Word Underline
	Ctrl+Shift+
	W
	

	Wrap Boundary
	
	
	Text Wrapping


* Shortcut key to mouse right click Shift + F10.
